
 

 

BAB III 

METODE PENELITIAN 

A. PENDEKATAN PENELITIAN 

Pendekatan penelitian yang digunakan dalam penelitian ini adalah 

Kuantitatif.  Pendekatan kuantitatif yang digunakan yaitu survei. 

Menurut Husna, A,  dkk (2017:65) mengemukakan bahwa survei 

adalah kajian terhadap sejumlah orang yang memungkinkan peneliti 

untuk memaparkan semua populasi yang diwakilinya dengan risiko 

terjadinya kesalahan sampel. Contoh tidak semua siswa dilibatkan 

untuk mengetahui nilai matematika tetapi murid diwakili oleh 

sejumlah murid yang karena alasan tertentu dianggap dapat mewakili 

murid yang lain.  

B. METODE/BENTUK  PENELITIAN 

1. Metode Penelitian  

Menurut Sugiyono (2017:117) metode penelitian kuantitatif 

komparatif berarti menguji parameter populasi yang berbentuk 

perbandingan melalui ukuran sampel yang juga berbentuk 

perbandingan. Hal ini juga berarti menguji kemampuan generalisasi 

(signifikansi hasil penelitian) yang berupa perbandingan karena 

variabel dari dua sampel atau lebih. 
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2. Bentuk Penelitian 

Bentuk penelitian yang digunakan dalam penelitian ini adalah 

penelitian eksperimen. Menurut Husna, A, dkk (2017:83-84) 

penelitian eksperimen adalah jenis penelitian di mana kondisi subjek 

diubah dan faktor luar dikontrol dengan ketat. Penelitian eksperimen 

juga melibatkan subjek pembanding atau metode ilmiah yang 

sistematis yang digunakan untuk menciptakan hubungan antara 

fenomena sebab-akibat. Penelitian eksperimental dapat menguji 

hipotesis hubungan kausal (sebab-akibat).  

Pada penelitian ini desain penelitian yang digunakan yaitu Quasy 

Eksperimental Design dengan bentuk Pretest – Posttest Control 

Group Design. Pada Pretest – Posttest Control Group Design terdapat 

dua kelompok yang masing-masing di pilih secara random. Kelompok 

pertama diberikan perlakuan (X) dan kelompok kedua tidak. 

Kelompok yang diberi perlakuan disebut kelompok eksperimental dan 

yang tidak diberi perlakuan disebut kelompok kontrol. Kelompok 

pertama diterapkan model pembelajaran team games tournament dan 

kelompok kedua tidak diterapkannya model pembelajaran team games 

tournament.  Berikut ini adalah bentuk Pretest – Posttest Control 

Group Design. 

Pretest Treatment Postest 

𝑶𝟏 X 𝑂3 

𝑶𝟐  𝑂4 
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Keterangan :  

𝑂1 = Sebelum diberikan perlakuan  di kelas eksperimen 

𝑂2 = Setelah diberikan perlakuan di kelas eksperimen 

X = Model pembelajaran team games tournament 

𝑂3 = Perlakuan di kelas kontrol 

𝑂4 = Perlakuan di kelas kontrol 

3. Prosedur Penelitian  

Adapun beberapa tahapan dalam penelitian ini antara lain sebagai berikut: 

a. Tahap Perencanaan 

1) Melakukan kegiatan observasi di lapangan untuk melihat secara langsung 

permasalah yang ada di sekolah tersebut (kondisi awal pembelajaran) 

2) Membuat instrumen penelitian yaitu soal uji coba untuk menentukan soal 

pretest dan postest yang akan digunakan dalam penelitian. 

3) Menyiapkan perangkat pembelajaran yang sesuai dengan model 

pembelajaran team games tournament. 

4) Melaksanakan validasi isi dengan meminta bantuan validator guna 

memvalidasi perangkat pembelajaran dan instrumen penelitian yang akan 

peneliti gunakan pada saat penelitian.  

5) Perbaikan perangkat pembelajaran dan instrumen jika masih terdapat 

kekurangan maupun kesalahan dalam pembuatannya.  

6) Membuat surat izin untuk pelaksanaan uji coba soal penelitian pada 

tanggal 29 Mei 2024 di SMP Panca Setya 2 Sintang.  
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b. Tahap Pelaksanaan 

1) Melakukan pengisian angket minat dan pretest untuk mengetahui minat 

dan hasil belajar siswa sebelum diberi perlakuan 17 Januari 2024.  

2) Memberikan perlakuan dengan model pembelajaran team games 

tournament pada kelas eksperimen dan model pembelajaran konvensional 

pada kelas kontrol pada 29 Mei 2024.  

3) Setelah dilaksanakan perlakuan dilanjutkan dengan melakukan pengisian 

angket minat belajar dan postest untuk mengetahui peningkatan minat dan 

hasil belajar siswa pada tanggal 30 Mei 2024. 

4) Dilanjutkan dengan pengisian angket respon siswa pada tanggal 11 Juni 

2024 

c. Tahap Evaluasi 

1) Mengolah data yang didapat dari angket minat, pretest, dan postest.  

2) Mendeskripsikan data untuk menjawab rumusan masalah.  

3) Menganalisis data dengan rumus statistik yang telah ditentukan.  

4) Menyimpulkan hasil pengolahan data dan penganalisisan data untuk 

menjawab rumusan masalah dalam penelitian ini.  

C. POPULASI DAN SAMPEL 

1. Populasi  

Populasi adalah wilayah generalisasi yang terdiri atas: obyek/subyek 

yang mempunyai kualitas dan karakteristik tertentu yang ditetapkan oleh 

penulis untuk dipelajari dan kemudian ditarik kesimpulannya (Sugiyono 



41 

 

 

 

2017:61). Populasi dalam penelitian ini yaitu siswa SMP Panca Setya 2 Sintang 

kelas VII yang berjumlah  107 pada tahun 2024. 

      

Tabel 3. 1 Populasi siswa aktif SMP Panca Setya 2 Sintang 
Kelas Jumlah siswa 

7A 29 

7C 26 

7D 26 

7E 26 

Jumlah 107 Siswa 

2. Sampel  

Sampel adalah bagian dari jumlah dan karakteristik yang 

dimiliki oleh populasi (Sugiyono 2017:62). Teknik pengambilan 

sampel yang digunakan oleh penulis dalam penelitian ini yaitu teknik 

probability sampling. Probability sampling adalah teknik pengambilan 

sampel yang memberikan peluang yang sama bagi setiap populasi 

untuk dipilih menjadi anggota sampel (Sugiyono 2017:63).  Teknik 

probability sampling dalam penelitian ini yaitu simple  random 

sampling.  Simple  random sampling adalah pengambilan anggota 

sampel dalam populasi dilakukan secara acak (Sugiyono 2017:63). 

Sampel di pilih tanpa adanya pemilihan individu sebagai sampel. Hal 

ini dilakukan mengingat dan mempertimbangkan sulitnya mengubah 

kelas yang sudah terbentuk. Pada penelitian ini sampel yang diambil 

adalah siswa kelas VII C dan VII D SMP Panca Setya 2 Sintang pada 

tahun 2024 kelas yang terpilih sebagai sampel yang mewakili 

populasi.  



42 

 

 

 

D. TEKNIK DAN ALAT PENGUMPUL DATA 

1. Teknik Pengumpul Data 

a. Kuesioner 

Menurut Husna, A., dkk (2017:126)  angket sebagai alat 

pengumpul data umumnya terdiri dari serangkaian pertanyaan atau 

pernyataan tertulis yang digunakan untuk mengumpulkan informasi 

penelitian yang dikehendaki.  

b. Pengukuran   

Pengukuran menyediakan sarana yang dapat digunakan untuk 

mengumpulkan informasi yang diperlukan, tes adalah alat atau 

instrunem yang digunakan untuk mengumpulkan informasi. 

c. Dokumentasi 

Menurut Asmaul Husna, dkk (2017:125) dokumentasi 

digunakan untuk mengidentifikasi kecenderungan dalam penelitian 

dan praktek mengenai suatu fenomena dalam suatu bidang. 

Dokumentasi juga digunakan untuk memperteguh bukti di 

lapangan. 

2. Alat Pengumpul Data 

a. Lembar Angket 

Menurut  Milawati, N.A (2019:52) angket merupakan 

teknik pengumpulan data berupa daftar pertanyaan secara tertulis 

yang harus diisi oleh responden sesuai petunjuk pengisian. Angket 

yang digunakan dalam penelitian ini adalah angket dengan skala 
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likert. Angket yang digunakan dalam penelitian ini ada dua yaitu 

angket minat belajar siswa dan angket respon siswa terhadap model 

pembelajaran team games tournament.  

1) Angket Minat Belajar 

Pertanyaan atau pernyataan dalam kuesioner diupayakan 

agar mewakili semua jawaban yang mungkin dipilih oleh 

responden. Pada lembar angket minat ada beberapa indikator yaitu 

perasaan senang, ketertarikan siswa,menunjukkan perhatian, 

keterlibatan siswa, dan kesadaran belajar tanpa di suruh. Adapun 

kriteria penilaian angket minat belajar sebagai berikut ini. 

Rumus : 

Minat Siswa = 
𝑇𝑜𝑡𝑎𝑙 𝑆𝑘𝑜𝑟 𝑦𝑎𝑛𝑔 𝐷𝑖𝑝𝑒𝑟𝑜𝑙𝑒ℎ

𝑇𝑜𝑡𝑎𝑙 𝑆𝑘𝑜𝑟 𝑀𝑎𝑘𝑠𝑖𝑚𝑎𝑙
 x 100% 

Tabel 3. 2 Kriteria angket minat belajar siswa 

Skor Kriteria 

76%-100% Sangat Tinggi  

51%-75% Tinggi  

26%-50% Cukup 

0%-25% Sangat Rendah 

Sumber: Sholehah, S. H., Handayani, D. E., & Prasetyo, S. A. 

(2018). Minat belajar siswa pada mata pelajaran matematika kelas 

IV SD Negeri Karangroto 04 Semarang. Mimbar Ilmu, 23(3), 

237-244. 

 

2) Angket Respon 

Pada penelitian ini angket respon siswa terhadap 

penggunaan model pembelajaran team games tournament  di isi 

oleh kelas ekperimen. Angket respon yang digunakan adalah 
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angket dengan skala likert dengan 10 pernyataan. Adapun kriteria 

angket respon sebagai berikut. 

Rumus: 

P = 
𝐹

𝑁
 x 100% 

Keterangan : 

P = Presentase Jawaban Responden  

F = Jumlah Jawaban Responden  

N = Jumlah Seluruh Skor Ideal 

Tabel 3. 3 Kriteria Angket respon 

Skor Kriteria 

81%-100% Respon Sangat Baik 

61%-80% Respon Baik 

41%-60% Respon Cukup 

21%-40% Respon Kurang 

0%-20% Respon Sangat Kurang 

Sumber: Riduwan dalam Dipraya, N.W penerapan model 

pembelajaran Think-Pair-Share (TPS) Mata diklat membaca gambar 

teknik untuk meningkatkan hasil belajar siswa SMK negeri 7 

Surabaya 

 

b. Soal Tes 

Menurut Husna, A., dkk (2017:135) tes merupakan alat 

yang digunakan untuk mengukur kemampuan subjek penelitian. 

Bentuk soal yang akan diberikan kepada siswa berupa soal essay 

untuk mengukur hasil belajar. Pada penelitian ini menggunakan 

soal yang sama. Posttest untuk mengukur tingkat keberhasilan 

siswa melalui tes instrumen yang diberikan pada akhir materi. 

Adapun indikator pada soal test yaitu siswa dapat memahami 
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konsep penyajian data, siswa dapat memahami cara pengumpulan 

data, dan siswa dapat menjajikan data. 

E. TEKNIK ANALISIS DATA 

Analisis data dapat dilakukan secara kuantitatif dengan 

menggunakan statistik inferensial. Menurut Sugiyono (2017:23) 

"Statistik inferensial adalah statistik yang digunakan untuk 

menganalisis data sampel, dan hasilnya akan digeneralisasikan 

(diinterfensikan) untuk populasi dimana sampel diambil". Kegiatan 

dalam analisis data adalah mengelompokan data berdasarkan variabel 

dua jenis responden, data berdasarkan variabel dari seluruh responden, 

menyajikan data tiap variabel yang diteliti melakukan perhitungan 

untuk menjawab rumusan masalah, dan melakukan perhitungan untuk 

menguji hipotesis yang telah diajukan. 

1. Uji Instrumen Penelitian 

a) Uji Validitas 

Menurut Husna, A., dkk (2017 :143)  uji validitas digunakan 

untuk mengetahui valid atau tidaknya suatu instrumen penelitian. 

Validitas pada sebuah instrumen dibagi menjadi tiga bentuk, yaitu 

yang pertama adalah validitas konten yang artinya item-item yang 

sudah dianalisis sudah sesuai dengan konten yang terdapat dalam 

item.  

Rumus : 

r = 
𝑛 Σ𝑥𝑦 − (Σ𝑥) (Σ𝑦)

√(𝑛Σ𝑥2−(Σ𝑥)2− (𝑛Σ𝑦2−(Σ𝑦)2
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Keterangan: 

r = koefisien korelasi  

Σ𝑥 =  jumlah skor item  

Σ𝑦 = jumlah skor total item  

n =  jumlah responden 

Jika r hitung > r tabel maka item pertanyaan valid. Jika r hitung < r 

tabel maka item pertanyaan tidak valid. 

Pengklasifikasian validitas seperti yang ditunjukkan pada kriteria 

sebagai berikut. 

Tabel 3. 4 Kategori Uji Validitas 

Nilai Keterangan 

0,80 − 1,00 Sangat Tinggi 

0,60− 0,80 Tinggi 

0,40 − 0,60 Cukup 

0,20 − 0,40 Rendah  

0,00 − 0,20 Sangat rendah 

Sumber:Misgirawanti pengaruh model pembelajaran kooperatif tipe 

team games tournament (tgt) terhadap minat dan prestasi belajar 

peserta didik materi sistem gerak kelas viii mts an-nur palangka raya 

 

Langkah-langkah dalam uji validatas dengan bantuan SPSS antara 

lain sebagai berikut. 

1) Melakukan tabulasi data dari google form ke microsoft excel 

2) Copy data dari excel termasuk skor total dan paste-kan ke SPSS 

(data view) 

3) Sebelum diolah, periksa kembali nama item di menu variabel view 

4) Selanjutnya pada menu data view, klik menu analyze, lalu klik 

correlate lalu bivariate disebelahnya 
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5) Blok semua item pernyataan termasuk total lalu klik tanda panah di 

tengah nya dan pindahkan ke kolom variables 

6) Klik pearson di menu correlate coefisients, klik two-tailed di menu 

test of significance dan selanjutnya klik di flag significant 

correlation dan klik OK. 

7) Selanjutnya akan muncul data output yang menunjukkan nilai 

pearson correlation pada total dari setiap item pernyataan 

Berikut ini adalah hasil uji validitas soal ji coba. Soal untuk pretest 

dan postest di uji cobakan terlebih dahulu kepada siswa kelas VII E yang 

berjumlah 21 orang pada tanggal 22 Mei 2024 untuk menguji kevalidan soal 

tes.  Pada penelitian ini sebelum melaksanakan proses pembelajaran di kelas 

akan di berikan soal uji coba. Tujuan dari soal uji coba ini adalah untuk 

mengetahui apakah soal yang akan digunakan dalam penelitian valid atau 

tidak. Berikut ini adalah hasil soal yang telah di uji cobakan kepada 21 siswa. 

Tabel 3. 5 Hasil Validitas Soal Uji Coba 

No  Indikator Nomor Soal Keterangan  

1 Siswa dapat mengingat 

penyajian data  

1 Cukup 

2 Siswa dapat memahami cara 

mengumpulkan data  

2 Cukup 

3 Tinggi 

3 Siswa dapat 

menyajikan/menerapkan data  

4 Tinggi 

4 Siswa dapat menganalisis 

penyajian data  

5 Cukup  
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Berdasarkan hasil uji coba di atas maka dapat dinyatakan 

bahwa 3 soal berada pada kriteria cukup dan 2 soal berada pada kriteria 

tinggi. Hasil uji SPSS dapat di lihat pada lampiran 29 (halaman 158). 

b) Uji Reliabilitas 

Menurut Husna, A., dkk (2017 :146)  uji reliabilitas instrumen 

dilakukan dengan tujuan untuk mengetahui konsistensi dari instrumen 

sebagai alat ukur, sehingga hasil suatu pengukuran dapat dipercaya. 

Penelitian ini menggunakan teknik pengujian reliabilitas menggunakan 

cronbach alpha di mana rumus ini digunakan untuk satu kali uji coba.  

Rumus : 

r = (
𝑛

𝑛−1
) (
Σ𝜎𝑡

2

𝜎𝑡
2 ) 

Keterangan: 

𝑟 = reliabilitas yang dicari  

𝑛 = jumlah item pertanyaan yang di uji 

Σ𝜎𝑡
2 = jumlah varians skor tiap-tiap item 

𝜎𝑡
2 = varians total 

Jika 𝑟    0,60 artinya  reliabel. Jika 𝑟    0,60 artinya tidak reliabel 

Langkah-langkah dalam uji releabilitas dengan bantuan SPSS 

antara lain sebagai berikut.  

1) Data yang sudah ditabulasi di excel di copy dan paste-kan ke 

SPSS 

2) Masukan skor masing-masing variabel kecuali total 

3) Selanjutnya klik menu analyze, lalu pilih menu scale, lalu pilih 

menu reliability analysis 
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4) Pada kotak sebelah kiri blok semua item kemudian klik tanda 

panah dan pindahkan ke kotak samping kanan 

5) Selanjutnya akan muncul data output 

Untuk melihat apakah instrumen cukup dapat dipercaya untuk 

digunakan sebagai alat ukur data, maka dilakukan uji reliabilitas. Rumus yang 

digunakan adalah rumus Alpha. Adapun hasil dari uji reliabilitas sebagai 

berikut. 

Tabel 3. 6 Hasil Uji Reliabilitas 

Reliability Statistics 

Cronbach's 

Alpha 

N of 

Items 

,646 5 

 

Berdasarkan nilai Cronbach’s Alpha pada hasil perhitungan 

menggunakan bantuan SPSS diperoleh nilai 0,646, ini berarti instrumen 

tersebut reliabel. 

c) Uji Daya Pembeda 

Daya pembeda adalah angka yang menunjukkan perbedaan kelompok 

tinggi dengan kelompok rendah. Menentukan daya pembeda soal dengan 

rumus menurut Daryanto dalam Misgirawanti (2019 : 70): 

D = 
𝐵𝐴

𝐽𝐴
 - 
𝐵𝐵

𝐽𝐵
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Keterangan: 

D = Jumlah siswa 

𝐵𝐴 =  Banyaknya siswa kelompok atas 

𝐵𝐵 = Banyaknya siswa kelompok bawah 

𝐽𝐴 = Banyaknya kelompok atas yang menjawab soal dengan benar 

𝐽𝐵 = Banyaknya kelompok bawah yang menjawab soal dengan 

salah 

Pengklasifikasian daya pembeda  seperti yang ditunjukkan 

pada kriteria sebagai berikut:   

Tabel 3. 7 Kategori Uji Daya Pembeda 

Nilai Keterangan 

0,70 – 1,00 Baik Sekali 

0,40 – 0,69 Baik 

0,20 – 0,39 Cukup 

0,00 – 0,19 Jelek  

Sumber:Misgirawanti pengaruh model pembelajaran kooperatif tipe 

team games tournament (tgt) terhadap minat dan prestasi belajar 

peserta didik materi sistem gerak kelas viii mts an-nur palangka raya 

 

Langkah-langkah dalam uji daya pembeda dengan bantuan SPSS 

antara lain sebagai berikut. 

1) Buka program SPSS, impor atau masukkan data yang ingin 

Anda analisis 

2) Pilih menu "Analyze" di bagian atas jendela SPSS. 

3) Pilih "Correlate" dan kemudian “Bivariate” 
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4) Pilih semua item  ke kolom variabel sebalah kanan 

5) Centang pearson → Two-tailed → Flag significant correlations 

→ ok 

Untuk menentukan daya pembeda instrumen soal pretest dan postest, 

maka dilakukan uji daya beda menggunakan bantuan SPSS. Adapun hasilnya 

adalah sebagai berikut. 

Tabel 3. 8 Hasil Uji Daya Pembeda 

No  Indikator  Daya pembeda Keterangan 

1 Siswa dapat mengingat penyajian 

data  

0,687 Baik 

2 Siswa dapat memahami cara 

mengumpulkan data  

0,596 Baik 

  0,622 Baik 

3 Siswa dapat menyajikan/menerapkan 

data  

0,566 Baik 

4 Siswa dapat menganalisis penyajian 

data  

0,566   Baik 

 

Berdasarkan hasil uji di atas dinyatakan bahwa 5 soal berada pada 

kriteria baik. Hasil uji SPSS dapat di lihat pada lampiran 30 (halaman 159). 

d) Uji Tingkat Kesukaran 

Tingkat kesukaran soal adalah besaran yang digunakan untuk 

menyatakan apakah suatu soal termasuk ke dalam kategori mudah, sedang atau 

sukar. Untuk mengetahui indeks kesukaran dapat digunakan rumus menurut 

Arikunto dalam Misgirawanti (2019 : 48). 

P = 
𝐵

𝐽𝑆
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Keterangan: 

P = Indeks kesukaran 

B = Jumlah skor peserta didik menjawab soal tes dengan benar tiap soal. 

JS = Jumlah seluruh siswa peserta tes 

Pengklasifikasian tingkat kesukaran  seperti yang ditunjukkan pada kriteria 

sebagai berikut: 

Tabel 3. 9 Kategori Uji Tingkat Tesukaran 
Nilai Keterangan 

0,71 – 1,00 Mudah 

0,31 - 0,70 Sedang 

0,00 - 0,30 Sukar 

Sumber:Misgirawanti pengaruh model pembelajaran kooperatif tipe 

team games tournament (tgt) terhadap minat dan prestasi belajar 

peserta didik materi sistem gerak kelas viii mts an-nur palangka raya 

 

Langkah-langkah dalam uji tingkat kesukaran  dengan bantuan SPSS antara 

lain sebagai berikut. 

1) Buka program SPSS 

2) Pastikan data Anda terorganisir dengan baik dalam format yang sesuai 

di SPSS. 

3) Pilih menu "Analyze"  

4) Pilih menu Descriptive Statistics → frequencies 

5) Pindahkan semua item soal ke kolom variabel → Statistics →central 

tendency → centang mean →continue → ok 
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Untuk menentukan daya pembeda instrumen soal, maka dilakukan uji daya 

beda menggunakan bantuan software SPSS. Adapun hasilnya adalah sebagai 

berikut. 

Tabel 3. 10 Hasil Uji Tingkat Kesukaran 

No  Indikator  Tingkat kesukaran Keterangan  

1 Siswa dapat mengingat 

penyajian data  

0,452 Sedang 

2 Siswa dapat memahami cara 

mengumpulkan data  

0,785 Mudah 

  0,524 Sedang  

3 Siswa dapat 

menyajikan/menerapkan data 

0, 428 Sedang 

4 Siswa dapat menganalisis 

penyajian data  

0,5 Sedang 

 

Berdasarkan hasil uji di atas dapat dinyatakan bahwa  4 soal berada pada 

kriteria sedang dan 1 soal berada pada kriteria mudah. Hasil uji SPSS dapat di 

lihat pada lampiran 31 (halaman 160). 

2. Uji Prasyarat 

a. Uji Normalitas 

Menurut Gunawan, M.A, (2015:65-68) uji normalitas data 

dimaksudkan untuk memperlihatkan bahwa data sampel berasal dari populasi 

yang berdistribusi normal. 

Rumus : 

𝓍2 = 
[(𝑛1 − 𝑛2) −1]

2

𝑛1 + 𝑛2
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Keterangan: 

𝓍2 = Chi Kuadrat 

𝑛1 = banyak data positif 

𝑛2 = banyak data negatif 

Pengklasifikasian normalitas  seperti yang ditunjukkan pada kriteria sebagai 

berikut. 

Tabel 3. 11 Kategori Uji Normalitas 
Nilai Keterangan 

Sig   0,005 Normal 

Sig   0,005 Tidak Normal 

Sumber:Misgirawanti pengaruh model pembelajaran kooperatif 

tipe team games tournament (tgt) terhadap minat dan prestasi 

belajar peserta didik materi sistem gerak kelas viii mts an-nur 

palangka raya 

 

Langkah-langkah dalam uji normalitas dengan bantuan SPSS antara lain 

sebagai berikut: 

1) Buka program SPSS 

2) Copy semua data yang ingin di uji  

3) Pilih menu berikut: Analyze  →  Descriptives Statistics →Explore  

4) Setelah muncul kotak dialog Explore masukan  hasil belajar ke 

Dependent list 

5) Masukan kelas  ke factor list  

6) Pilih tombol Plots, centang normality plots with tessts  

7) Berikan tanda centang, lalu tekan Continue 

8) Pilih OK 
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Karena data berdistribusi normal maka uji yang digunakan 

adalah t-test. 

Rumus : 

t = 
𝑥1̅̅̅̅  − 𝑥2̅̅̅̅

√
𝑆
12

𝑛1
+
𝑆
22

𝑛2

 

Keterangan: 

𝑥1̅̅̅  = rata-rata sampel 1 

𝑥2̅̅ ̅ = rata-rata sampel 2 

𝑆1 = simpangan baku sampel 1 

𝑆2 = simpangan baku sampel 2 

𝑆12 = varians sampel 1 

𝑆22 = varians sampel 2 

b. Uji Homogenitas 

Menurut Gunawan, M.A, (2015:75) uji homogenitas 

dimaksudkan untuk memperlihatkan bahwa dua atau lebih 

kelompok data sampel berasal dari populasi yang memiliki 

variansi yang sama. Pada penelitian ini uji homogenitas yang 

digunakan yaitu uji levene. Uji levene untuk menguji apakah 

varians antar kelompok atau perlakuan sama atau tidak. 

 

 

 



56 

 

 

 

Rumus: 

W = 
(𝑁− 𝑘)

(𝑘 − 1)
 x 

∑ 𝑁     ̅̅ ̅−    ̅̅ ̅)
2 

    1

∑ ∑       
  
    1

   ̅̅ ̅)
2 

    1

 

Keterangan: 

W = statistik uji Levene. 

N = jumlah total observasi. 

k = jumlah kelompok. 

 𝑖 = jumlah observasi dalam kelompok ke-i. 

   ̅̅ ̅ = rata-rata dalam kelompok ke-i. 

 ̅   = rata-rata umum dari semua data. 

 𝑖   = setiap nilai observasi dalam kelompok ke-i. 

Pengklasifikasian homogenitas  seperti yang ditunjukkan pada 

kriteria sebagai berikut: 

Tabel 3. 12 Kategori Uji Homogenitas 

Nilai Keterangan 

Sig   0,005 Homogenitas 

Sig   0,005 Tidak Homognitas 

Sumber:Misgirawanti pengaruh model pembelajaran kooperatif 

tipe team games tournament (tgt) terhadap minat dan prestasi 

belajar peserta didik materi sistem gerak kelas viii mts an-nur 

palangka raya 

 

Langkah-langkah dalam uji homogenitas dengan bantuan SPSS 

Menurut Muhammad Ali Gunawan, (2015: 81-83) antara lain 

sebagai berikut. 
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1) Buka SPSS 

2) Copy semua data yang ingin di uji 

3) Pilih menu Analyze → Compare means → One –Way 

ANOVA 

4) Hasil belajar dependent list dan kelas sebagai factor list 

5) Klik tombol options → Homogenity of variance test 

6) Klik Continue lalu klik OK 

3. Uji Hipotesis 

Uji hipotesis adalah sebuah proses untuk melakukan 

evaluasi kekuatan bukti dari sampel, dan memberi dasar untuk 

mengambil sebuah keputusan terkait dengan populasi. Tujuan 

uji hipotesis untuk membuat keputusan apakah hipotesis yang 

di uji ditolak atau diterima.  

Pada penelitian ini uji yang digunakan adsalah uji t 

(parsial). Salah satu test statistik yang dipergunakan untuk 

menguji kebenaran atau kepalsuan hipotesisadalah uji t (uji 

parsial) . Kriteria pengambilan keputusan uji t dalam penelitian 

ini adalah jika nilai sig   0,005 maka  𝑎 di terima atau 

terdapat pengaruh dan jika nilai sig   0,005 maka  𝑜 di terima 

atau tidak terdapat pengaruh. 

Rumus: 

t = 
𝑥1̅̅̅̅  − 𝑥2̅̅̅̅

√
𝑆
12

𝑛1
+
𝑆
22

𝑛2
− 2𝑟 (

𝑆1

√𝑛1
) (

𝑆2

√𝑛2
)
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Keterangan: 

𝑥1̅̅̅  = rata-rata sampel 1 

𝑥2̅̅ ̅ = rata-rata sampel 2 

𝑆1 = simpangan baku sampel 1 

𝑆2 = simpangan baku sampel 2 

𝑆12 = varians sampel 1 

𝑆22 = varians sampel 2 

r = Korelasi antara dua sampel 

Langkah-langkah dalam uji t dengan bantuan SPSS antara 

lain sebagai berikut. 

1) Buka program SPSS  

2) Masukkan data hasil penelitian pada kolom yang sesuai 

pada data view 

3) Pilih Menu Analyze → Compare Mean →Paired-

Sample t-Test 

4) Pindahkan variabel ke kolom yang sesuai pada kotak 

dialog Paired Sample-t Test  

5) Klik Options → Continue pilih Ok. 




